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CHAPTER

ONE

USIM QUICK START: GETTING STARTED WITH THE USIM SERIES
OF COMPUTATIONAL APPLICATIONS

Welcome to the USim series of computational applications, powered by the Ulixes computational engine. Ulixes is
a general purpose fluid plasma modeling code that supports shock capturing methods for MHD, Hall MHD, Two-
Fluid plasma, Navier Stokes, and Maxwell’s equations as well as multi-species, multi-temperature versions of the
fluid systems mentioned. The equation systems can be solved on bodyfitted and unstructured grids in 1, 2, and 3
dimensions. Navier Stokes and MHD models allow for user specified equations of state along with the ability to
use PROPACEOS tables (purchased from Prism Computational Sciences). USim has the ability to model the plasma
device as part of a circuit. Recent applications of USim have included modeling merging plasma jets, laboratory
accretion disk experiments, weakly ionized hypersonic flow modeling, magnetic nozzles and capillary discharges.
USim is a multi-platform tool and runs on Windows, OS X, and Linux.

This manual, USim Quick Start, provides hands-on training for new users of the USim series of computational appli-
cations. It demonstrates how to carry out simulations using the USimComposer interface to the input files.

The USimComposer interface allows you to edit and validate your simulation input files, run simulations in either serial
or parallel (thereby utilizing multiple cores or even computational nodes that do not share memory), and visualize
results. USimComposer provides GUI editing of the main input variables of appropriately marked-up input files.
However, one can still edit input files in any text editor, execute through the command line and visualize in any tool
that understands the HDF5 output.

USim installation instructions are given in the document, installation.

The subsequent sections provide examples that can be run through USimComposer. Each section is named for the
USim package or module that is needed to run those examples. That is, the USimBase chapter contains the examples
that can be run with a USimBase license, for example. All examples can be run with a full USim license.

After learning how to run the USim applications through USimComposer, you can turn to the manual, usim-in-depth,
to learn how to edit input files directly to create your own custom simulations. All input file blocks are specified in the
manual, usim-reference.

1
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CHAPTER

TWO

USIMCOMPOSER INTRODUCTION

This introduction to the USimComposer Graphical User Interface demonstrates setting up, running, and visualizing
simulations. The rest of USim Quick Start assumes that you have reviewed this section to familiarize yourself with the
USimComposer GUI.

The first sub-section provides an explanation of the basic workflow through the application - consisting of the three
steps Setup, Run, and Visualize. Following this portion of the document is a detailed explanation of the options and
commands available through the menu bar at the top of the USimComposer window. Finally, this section includes
explanations of the default USim settings supplied by USimComposer.

In the HTML version of this document, click on any illustration to see a full size view. The images presented in
this section have been captured on a computer running Mac OS X; the USimComposer interface will appear slightly
different on Windows and Linux platforms.

Setup Window showing main USimComposer parts. illustrates the layout of the USimComposer GUI using labels for
the parts of the interface to which this introduction and the tutorials refer.

2.1 Setup

2.1.1 Create New Runspace From Example

To run one of the examples in USim, one must first create a runspace from the many templates that come with USim.
There are two ways to create a runspace from one of the templates. The first is to choose “New from Template...” from
the File menu. The second is in the Setup Window. In the Setup Window, click on the New button next to New From
Template... in the middle of the Setup Window. See Setup Window.

2.1.2 Select Example Template

From the “New from Template” dialog, choose a new example template from one of the packages. Only those tem-
plates which you have licensed will run, though all examples will still be shown.

If you have clicked once on your selection in the Choose Example pane, your selection is highlighted. Now click on
the Choose button in the lower right area of the New from Template window as in Selecting an example from the
“New from Template” Dialog. Alternatively, you could double-click on an example name and USim will behave the
same as if you had selected the example and then the Choose button.

For this example we will use the “USimBase - Flow over a forward facing step” example.

3
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Fig. 2.1: Setup Window showing main USimComposer parts.
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Fig. 2.2: Setup Window
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Fig. 2.3: Selecting an example from the “New from Template” Dialog
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2.1.3 Choose a Name for the New Runspace

The window Choose a name for the new Runspace allows you to choose the directory to which the example files will
be copied from the template. The default name of the directory is displayed in the FileName field. For this example,
the default name is forwardFacingStep. If you want to use a different name, you may type a different name into
the FileName field. When you are satisfied with the directory name and location, click the Save button to proceed.

Fig. 2.4: Create Directory to Use for Runspace

2.1.4 Using the Setup Window

After you choose the name for the runspace, USimComposer displays the Setup Window containing a Navigation
pane on the left and an Editor pane on the right. The workflow panel remains available on the far left.

Below the Runspace Files tab in the Navigation pane you will find a pulldown menu for which files are shown, which
defaults to All Files and a toggle choice of Smart Grouping, which is on by default. These menus determine the format
in which files will be displayed in the Files tab. Depending on how complex a simulation is, there may be multiple files
used in a simulation, including the input file, macros, and python geometry files. Many more files produced during the
simulation run at each time step of the run.

To enable convenient viewing of the list of simulation files, USim allows you to specify in what order as well as which
type(s) of files you would like to view. Smart Grouping causes similar types of files to be displayed in the same area of
the Files tab list. Turning off Smart Grouping causes files to be displayed in alphabetical order rather than by type. All

2.1. Setup 7
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Fig. 2.5: Setup Files Tab
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Files indicates that you want to see all available files involved in the simulation. You could choose to limit your view
to only Runspace Files, which are files such as input files and macros that can be edited in the USimComposer Editor
pane, or Text files, which include all types of human-readable file formats, or Data files, which include incremental
dump files and output files that can be visualized.

File name filtering with these pull-down menus is illustrated later in this document in the Visualization Pane section,
Results Pane.

In addition to Runspace Files, the Setup Window holds the tab to change the key parameters for a run and the Save and
Process Setup button. See The main parts of the Setup Window.

Fig. 2.6: The main parts of the Setup Window

Click on the Save and Process Setup button in the upper right corner of the USimComposer Setup window to validate
the input before running USim.

2.1.5 Key Input Parameters in the Setup Window

All the example files in USimComposer come with key parameters allowing the user to easily adjust basic parameters
of the simulation. The default setup window will show the key input parameters interface and an image of what the
simulation looks like. By holding the mouse over the key input paramater title, a description of what exactly the

2.1. Setup 9
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variable does will pop up. Many examples can actually be significantly modified with just the key input parameters
and extended for slightly different applications.

Fig. 2.7: Key input parameters or the full input file can be edited in the Setup Window

If you would like to see the actual input file, simply click on the View Input File in the upper left hand side of the
Editor pane. This will bring you to the traditional .pre file.

2.1.6 Save and Process the Input File

Click on the Save and Process Setup button in the upper right corner of the USimComposer Setup window as
illustrated in the image below.

2.1.7 View the Output Messages

USim notifies you of the actions that it is taking in a new window that USimComposer opens in the lower portion of
the Editor pane.

Notice that this new window contains three tabs: a Find/Replace tab an Output tab and a Results tab. If you had
clicked in any tab of the Editor window, the Find/Replace tab would have appeared to assist you with editing the file.

10 Chapter 2. USimComposer Introduction
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Fig. 2.8: Save and Process Setup Button
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The Output tab notifies you each step of the way as to what USim is doing as illustrated in Setup Window tab for
output message.

Fig. 2.9: Setup Window tab for output message

2.2 Run

2.2.1 Select the Run Window

When your Save and Process activity completes successfully, USim reminds you that you can now proceed to the run
part of the workflow. To do this, click on the Run button in the workflow panel on the far left of the USimComposer
window (see Setup Window showing main USimComposer parts.).

2.2.2 Using the Run Window

As in the USimComposer Setup window, the USimComposer Run window contains two panes. As displayed in Run
Window Figure, the Runtime Options window on the left contains a Standard tab and a MPI tab. The Logs and
Output Files pane on the right contains a Engine Log tab on the left and a File Browser tab on the right.

2.2.3 MPI (Parallel Execution) Options

USimComposer runs simulations in serial by default. If you are running on a local system with multiple cores, you can
run your simulation in parallel as multiple processes. The simplest method to tell USimComposer to run simulations
in parallel is to switch the number of processors to run in the Run window. In the upper-right portion of the Runtime
Options pane, there is a tab MPI. Here you can define the number to as few or many processes you want to run. If the
Run with MPI button is unchecked the simulation will run in serial mode. See Host Settings for a description of how
to set USim to run in parallel by default.

2.2.4 View the File Browser Tab in the Logs and Output Files Pane

In the previous step the File Browser tab was located behind the Engine Log tab in the Logs and Output Files pane.
Click on the File Browser tab to bring it to the front as shown in File Browser Tab in Logs and Output Files Pane.

Notice that as with the File Browser in the Setup window, the File Browser in the Run window also has the Smart
Grouping and All Files pull-down menus at the bottom of the tab.
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Fig. 2.10: Run Window Figure
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Fig. 2.11: MPI Options
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Fig. 2.12: File Browser Tab in Logs and Output Files Pane
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2.2.5 Run the Simulation

For our example, we’ll run this simulation using only the default existing settings from the input file.

You do not need to select any file in particular in the File Browser tab before clicking on the Run button. However,
if the File Browser tab display area is too narrow for you to see the full file names in the filename list and you would
like to see the file name extensions of the files in the file browser, you can adjust the width of the filename field by
using your mouse.

Click on the Run button at the top of the Logs and Output Files pane as shown in Run Button.

Fig. 2.13: Run Button

2.2.6 Stopping the Simulation

USimComposer features the ability to Force Stop a simulation. The button for this action is located next to the Run
button (see Run Button).

If a Force Stop is used the field and history data will NOT be written to a .h5 file before the simulation stops. The
output of a successfully force stopped simulation is given below.
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Fig. 2.14: Force Stopped Simulation
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2.2.7 Restarting a Simulation

With USimComposer it is possible to restart a simulation that has been paused, or ended. This is useful if it is desired to
add more time steps to the initial simulation, or if the simulation had been stopped in the middle of the run. Underneath
the Standard tab of the Runtime Options pane of the run window there is a Restart at Dump Number field. Simply put
in the last memory dump of the simulation and click on the Run button, like running a normal simulation. This process
is demonstrated in the figure below.

Fig. 2.15: Restarting a Simulation

2.2.8 View the Engine Log

Just as when processing the setup, USim again notifies you of the progress of its activity by reporting results along the
way in the Engine Log tab as shown in Engine Log. If the tab display area is full, scroll down to the bottom of the tab.
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Fig. 2.16: Engine Log
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2.3 Visualize

2.3.1 Selecting the Visualize Window

Notice that upon successful completion of the simulation run, the last message in the Engine Log tab is a reminder
that you can now select the Visualize button from the workflow panel on the far left of the USimComposer window as
seen in Engine Log. Remember that you may need to scroll down the Engine Log tab to see the completion message.

2.3.2 Visualize the Current Runspace Data

The simulation was successful and the next step is to visualize the data, Click on the Open Button in the Visualize
Window.

Fig. 2.17: Visualize Window Open Button

2.3.3 Data Visualization Window

USimComposer’s Visualization feature is a flexible and comprehensive model viewer based on VisIt. The simulation
tutorials and examples in USim Quick Start provide several examples of using the Visualization feature’s options in
context.
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The Visualization window is divided into a Controls pane on the left and a Results pane on the right.

As displayed in Controls and Results Visualization Panes, click on the right-facing triangle arrowhead next to Scalar
Data and Geometries to expand the views.

Fig. 2.18: Controls and Results Visualization Panes

2.3.4 Controls Pane

By default, the Controls Pane will open Data Overview as the Data View. Other Data Views such as Field Analysis
can be selected as shown in Data View Menu.

Fig. 2.19: Data View Menu
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Variables

The Variables section of the Controls pane enables you to choose which aspects of the simulation data to visualize.
The types of variables that are available in the Variables section are dependent on your particular simulation. Below
are some typically available types of variables.

Scalar Data

Types of Scalar Data include:

• fluids/machNumber

• fluids/q_n

Fig. 2.20: Scalar Data Variables

Note that 𝑞0 is mass density, 𝑞1, 𝑞2, and 𝑞3 are the three components of momentum density, and 𝑞4 is energy density.

Geometries

Types of Geometries include:

• fluids/domain
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• fluids/domain_surface

Fig. 2.21: Geometries Variables

Contours (2-30)

The default value in the Contours field is 10. If you select the Display Contours check box and have an approriate data
set selected the number of countours can be changed from 2-30

Log Scale Color Checkbox

If the appropriate field is selected the Log Scale Color checkbox will be available to enable and disable display of log
scale color.

Annotation Level Menu

Use the Annotation Level pulldown menu to add or remove annotation from the visualization.

• No annotations

• Axes only

• Axes & Legends
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Fig. 2.22: Contours
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Fig. 2.23: Log Scale Color Checkbox
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• All annotations

Fig. 2.24: Annotation Level

Reload Data

You can visualize data from a simulation run as soon as it becomes available in the runspace. If you decide to visualize
data before a run is complete by switching to the Visualization tool and using the Open visualization from current
runspace button in the Visualization window, USim continues creating data files in the background. Later when more
data is available for visualization or the simulation run is complete, use the Reload Data button to visualize the new
data.

Note: If the first visualization took place when there was only one dump, then the visualization system is completely
reloaded, which means that plots are not preserved. However, if the first visualization took place when there was more
than one dump, then all current plots and views are available when Reload Data is invoked.

2.3.5 Results Pane

The USimComposer Visualization Tool uses a window in the Visualization Results pane on the right side of the
USimComposer window to dynamically display data modeled according to the selected variables and other Controls
pane visualization configuration settings.
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Fig. 2.25: Controls Pane Buttons
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Example Visualizations

The following images illustrate how the various features of the Visualization Tool can be used to control rendering of
simulation data to help the user visually explore aspects of the simulation. Notice that the Visualization pane slider is
used to adjust values for:

• Dump

• Step

• Time

Fig. 2.26: Clip All Plots

Visualize Data from a Previous Run

In addition to visualizing the result of a current run immediately after conducting the simulation, you can also visualize
data from a previous run. You can access recent simulations using Recent Runspaces in the File menu in the menu bar
or the Welcome or you can locate all previous simulations using the Open Existing Runspaces in the Setup Window.

28 Chapter 2. USimComposer Introduction



USimQuickStart, Release 3.0.1

Open Recent Runspace from the File Menu

To access data to visualize from a recently conducted simulation, from the File menu in the menu bar, select Recent
Runspaces.

Fig. 2.27: Recent Runspaces Selection in File Menu

Click on the name of the runspace whose data you want to visualize. USimComposer lists the existing data files in the
selected runspace. Click on the Yes button if these are the files you want to visualize.

If you would prefer that USimComposer does not first list the names of the detected data files for you to inspect before
deciding whether you would like to visualize that data, click in the checkbox labeled Do not ask again. Clicking in
this checkbox will cause USimComposer from now on to immediately visualize the data from the selected runspace.

Open Runspace from the File Menu

If the simulation data you want to visualize was not produced recently, you can access the data from the File menu in
the menu bar, select Open Runspace....

Open an Existing Runspace from the Setup Window

Alternatively, if the simulation data you want to visualize was not produced recently, use the Setup Window instead of
Recent Runspaces. Return to the Setup window by clicking on the Setup icon in the icon panel then select the Open
button next to Open Existing Runspace as shown in Existing Run Space button.

USimComposer displays runspaces from which you may select.

If you did not previously elect not to display detected data files then just as with Open Recent Runspace from the File
Menu, USimComposer displays a list of data files that it has detected in the selected runspace, and you can click on
the Yes button to visualize the data.

Sorting and Filtering File List Display in the USimComposer File Browser

USim produces several different types of files with each simulation run. To make it easier to examine the files in a
runspace, USimComposer provides the ability to sort the file list by file type or file name and to isolate particular kinds
of files.
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Fig. 2.28: Data Files Detected in a Runspace
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Fig. 2.29: Existing Run Space button
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Fig. 2.30: Existing Run Space Selection
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Sorting Files into Groups

The checkbox at the bottom of the USimComposer File Browser enables you to choose whether or not to sort the the
list of files in a runspace. Smart Grouping, which is on by default, causes the type of files selected in the adjacent file
type pulldown menu to be listed together in logical groups. If not selected, the type of files selected in the adjacent file
type pulldown menu to be displayed in alphabetical order.

Fig. 2.31: Smart Grouping of All Files

Filtering Files by File Type

The pulldown menu at the bottom of the USimComposer File Browser enables you to filter the display of files by file
type.

All Files, which is the default, causes all file names to be displayed in the grouping indicated by the selected grouping
method in the adjacent pulldown menu.

Data Files with Smart Grouping displays the folder containing data files in the runspace.

Data Files with Smart Grouping

Data Files with No Grouping displays the names of the data files inside the data file folder.

Other options are Text Files and Runspace Files.
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Fig. 2.32: No Grouping of All Files
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Fig. 2.33: Data files with No Grouping
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2.4 USimComposer Menu Bar

This introduction to the USimComposer menu bar presents features accessible from the menu bar.

2.4.1 Menu Bar

The USimComposer menu bar is located across the top of the USimComposer window.

Fig. 2.34: USimComposer menu bar

2.4.2 File Menu

The File menu contains options to control creating, opening, closing, and saving USimComposer files and runspace
directories.

The New from Template feature is accessed from the USimComposer File menu.

Categories of templates from which to choose are listed in the left Available Templates pane of the New from
Template window. The description of the selected category is displayed in the right Description pane of the New
from Template window.
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Fig. 2.35: File Menu
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Fig. 2.36: New from Template Menu Selection
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The USimBase category contains a number of example simulation files that are used in USim Quick Start and available
with any USim license. As with the example categories, names of examples are listed in the left Available Templates
Example pane with the description corresponding to the currently selected example shown in the right Description
pane.

Fig. 2.37: USimBase Example list

To open a runspace directory where existing simulation files reside, select Open Runspace from the File menu.

The runs directory in the USimComposerX.X directory that is created in your home directory when you install is
the default directory in which runspace directories will be created when you use USimComposer to set up simulations.

2.4.3 Edit Menu

The Edit menu contains commands that pertain to editing activities in the Editor pane of the USimComposer window
during Setup.

2.4.4 Preferences or Tools Menu

The Preferences (Mac OS X) or Tools (Linux/Windows) menu provides access to global settings for USimComposer
applications from the icon panel.

Select USimComposer –> Preferences (Tools –> Settings) to access the Application Settings window.

The Applications Settings window is displayed with General highlighted.
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Fig. 2.38: Open Runspace selection from File menu
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Fig. 2.39: Open Runspace window
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Fig. 2.40: Select Edit menu
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Fig. 2.41: Select Settings from the Tools menu
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General

General Application Settings apply to default behavior for the USimComposer applications such as file and directory
actions.

Fig. 2.42: General Application Settings

The default setting that USimComposer will use when opening a runspace with existing data is Ask before opening
visualization. If you know that you will always want to visualize data whenever it is available, you may use the
pulldown menu to set the default to Always open visualization. If you prefer to indicate whenever you want to visualize
existing data by using the Visualize icon yourself instead of having USimComposer open the visualization of existing
data for you, you may use the pulldown menu to set the default to or Never open visualization.

The default setting that USimComposer will use when starting a run on a runspace that already contains data is Ask
before deleting existing data. If you know that you will always want to create fresh data for each run, use the pulldown
menu to set the default to Always delete existing data. If you know that you will always want to run on the data already
available, use the pulldown menu to set the default to Never delete existing data.

The default setting that USimComposer will use when opeing a runspace while another runspace is already opened is
Ask before saving files and command line options of existing runspace If you know that you will alaways want to save
the runspace this can be switched to Always save files and command line options of existing runspace. If you know
that you will never want to save the runspace this can be switched to Never save files and command line options of
existing runspace.
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Fig. 2.43: Application Setting When Opening Runspace with Existing Data

Fig. 2.44: Application Setting When Starting Run on a Runspace with Existing Data
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Fig. 2.45: Application Setting When Opening a Runspace When Another Runspace is Already Open

Host Settings

Paths

The default path that USimComposer will use as the top level directory to which to add runspace directories is dis-
played in the Host Settings window underneath the Paths tab in the Workspace Directory field. You can type in another
path if you so wish.

The USimComposer Installation Directory is used to let USimComposer know the correct paths to the Ulixes executa-
bles as well as other paths to allow USim to work.

MPI

By default, USim runs in serial mode. If you have a multi-core system capable of parallel processing, you can set the
default to parallel instead of serial by clicking on the Preferred Run Method drop down menu and selecting parallel.

USimComposer detects the number of available cores for the system on which it is running and lists this value in the
Cores On Machine field.

USimComposer reads the USim license file and sets the default number of Cores In License to match the number of
cores specified in the license file. If you would like to run simulations using fewer processes than the number of cores
for which your software is licensed or perhaps try some load balancing using more processes than you have cores, you
may change the number of cores by entering a new value in the Preferred Number of Cores field. When the value
in the Preferred Number of Cores field is set to something other than the last saved value, USimComposer places an
asterisk in front of the field label so that you are aware that you have changed the value and may wish to save the new
value.
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Fig. 2.46: Application Setting Engine Menu

Editor

The editor tab contains default settings for font and font size. These are editable to the users desired settings. Any file
with the extensions listed in the Extensions box will use the settings under Files with Fixed-width Font and all other
files under the All Other Files sections.

Visualization Options

The visualization options tab allows the user control over default settings of the Visualize tab in USimComposer. By
checking Manual font sizing the size of the fonts can be controlled. If Enable VisIt context menu is selected it will be
possible to right click on the visualization and open VisIt itself allowing the user access to every function and feature
of VisIt. It also enables the embedded point and line tools in VisIt as well as some of the generic view controls.

License Settings

It is possible to review your USim license, as well as install a new license if an upgrade or additional packages are
purchased.

To install a new license click on the Add button and navigate to where your new license is located, and hit ok.
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Fig. 2.47: Editor Menu

Fig. 2.48: Visualization Menu
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Fig. 2.49: License Settings Dialog
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CHAPTER

THREE

USIMBASE EXAMPLES

The USimBase examples demonstrate the basic solvers available in USim. The USimBase examples can be executed
with a USimBase license.

3.1 Flow over a Forward-Facing Step (forwardFacingStep.pre)

Keywords:

hydrodynamics, unstructured mesh, supersonic flow, shock wave generation, Forward-Facing Step , forwardFacingStep

3.1.1 Problem description

This problem demonstrates supersonic flow over a forward-facing step, involving Mach 3 flow at an inlet to a rect-
angular domain. A step is placed near the inlet region that generates shock waves. An unstructured mesh, with a
reflecting wall boundary at the step, is used in this example.

This simulation can be performed with a USimBase license.

3.1.2 Creating the run space

The Flow over a Forward-Facing Step example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Flow over a Forward-Facing Step and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as shown below. After any change is
made, the Save and Process Setup button must be pressed again before a new run may commence.

3.1.3 Input file features

The input file allows the user to set a variety of problem parameters related to the physics, initial conditions, domain
and solver used for the Flow over a Forward-Facing Step.

The following parameters control the physics:

51



USimQuickStart, Release 3.0.1

• MHD = False,True selects whether to evolve the problem in the inviscid hydrodynamic limit (MHD = False) or
the ideal magnetohydrodynamic limit (MHD = True).

• BETA controls the ratio of the gas pressure to the magnetic pressure for problems solved in the magnetohydro-
dynamic limit (i.e. when MHD = True).

• GAS_GAMMA sets the adiabatic index (ratio of specific heats) of the fluid.

• GRIDFILE Mesh file to use

• GRIDFORMAT Format of the mesh file (either ExodusII or Gmsh)

The following parameters the length of the simulation and data output:

• TEND sets the end time for the simulation.

• NUMDUMPS sets the number of data dumps during the simulation

• WRITE_RESTART = False,True tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to evolve the simulation:

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration.

• DIFFUSIVE = False,True sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

3.1.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

3.1.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Geometries in the Visualization Controls pane and click the checkbox for fluids/forwardFacingStep to
visualize simulation geometry.

• Expand Scalar Data and click the check box for fluids/density to visualize fluid densities.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The fluid
density distribution at the end of the simulation is shown in Fig. 3.1.
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Fig. 3.1: Visualization of the Flow over a Forward-Facing Step example using a color contour plot

3.1.6 Further experiments

Several Gmsh format mesh files are included with this example. The default file choice is “forwardFacingStep.msh”,
which is a low-resolution mesh partitioned for serial execution. Higher-resolution meshes (forwardFacingStep2.msh,
forwardFacingStep4.msh, forwardFacingStep8.msh) are included for 2, 4, and 8 core runs, respectively. To run the
example using the 2-core mesh, proceed as follows:

• Return to the Setup window by pressing the Setup icon in the workflow panel.

• Enter the mesh file name “forwardFacingStep2.msh” in the GRIDFILE text box.

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• In the Run window, press the MPI tab in the Runtime Options pane.

• Check the box marked Run with MPI and set Number of Cores equal to 2.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane. You
will again see the engine output in the Logs and Output Files pane‘.

After the simulation has executed, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Geometries in the Visualization Controls pane and click the checkbox for fluids/forwardFacingStep to
visualize simulation geometry.

• Expand Scalar Data and click the check box for fluids/density to visualize fluid densities.
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• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time.

3.2 Kelvin-Helmholtz Instability (khInstability.pre)

Keywords:

hydrodynamics, Kelvin-Helmholtz Instability

3.2.1 Problem description

This problem demonstrates the Kelvin-Helmholtz instability for the case of a velocity difference across the interface
between two different fluids that differ in density by a factor 2. A finite-width shear layer is used to ensure results
converge at finite resolution. For the two-dimensional version of the problem setup considered here, we use a domain

(−𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2,−𝑃𝐸𝑅𝑃𝐿𝐸𝑁𝐺𝑇𝐻/2)× (𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2, 𝑃𝐸𝑅𝑃𝐿𝐸𝑁𝐺𝑇𝐻/2)

with periodic boundary conditions in the PAR direction and reflecting wall boundary conditions in the PERP direction.
For the three-dimensional version of the problem setup considered here, we use a domain

(−𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2,−𝑃𝐸𝑅𝑃𝐿𝐸𝑁𝐺𝑇𝐻/2,−𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2)×(𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2, 𝑃𝐸𝑅𝑃𝐿𝐸𝑁𝐺𝑇𝐻/2, 𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2)

with periodic boundary conditions in the PAR directions and reflecting wall boundary conditions in the PERP direction.
A single mode perturbation is used to seed the instability.

This simulation can be performed with a USimBase license.

3.2.2 Creating the run space

The Kelvin-Helmholtz Instability example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Kelvin-Helmholtz Instability and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as shown below. After any change is
made, the Save and Process Setup button must be pressed again before a new run may commence.

3.2.3 Input file features

The input file allows the user to set a variety of problem parameters related to the physics, initial conditions, domain
and solver used for the Kelvin-Helmholtz instability.

The following parameters control the physics of the Kelvin-Helmholtz instability:

• MHD = False,True selects whether to evolve the problem in the inviscid hydrodynamic limit (MHD = False) or
the ideal magnetohydrodynamic limit (MHD = True).

• MACH_NUM sets the ratio of the flow velocity to the sound speed (the Mach number). Note that the Kelvin-
Helmholtz instability is stabilized for Mach Numbers greater than unity.
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• BETA controls the ratio of the gas pressure to the magnetic pressure for problems solved in the magnetohydro-
dynamic limit (i.e. when MHD = True). Note that, for strong enough magnetic fields (small enough BETA), the
Kelvin-Helmholtz instability is stabilized.

• GAS_GAMMA sets the adiabatic index (ratio of specific heats) of the fluid.

The following parameters control the shear layer that drives Kelvin-Helmholtz instability and the perturbation used to
seed the Kelvin-Helmholtz instability:

• SHEAR_LAYER_WIDTH sets the width of the shear layer. This should be resolved by 2-3 cells on the mesh in
order for the instability to grow.

• PERTURB_AMP sets the strength of the perturbation, seeding the instability relative to the flow velocity.

• PERTURB_WIDTH sets the spatial width of the perturbation that seeds the instability.

The following parameters control the dimensionality, domain size and resolution of the simulation:

• NDIM = 2,3 selects whether to run the problem in two- or three-dimensions.

• PAR_LENGTH sets the size of the domain in the direction parallel to the shear layer.

• PERP_LENGTH sets the size of the domain in the direction perpendicular to the shear layer.

• PAR_ZONES sets the number of zones in the direction parallel to the shear layer.

• PERP_ZONES sets the number of zones in the direction perpendicular to the shear layer.

The following parameters the length of the simulation and data output:

• TEND sets the end time for the simulation.

• NUMDUMPS sets the number of data dumps during the simulation

• WRITE_RESTART = False,True tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to evolve the Kelvin-Helmholtz instability:

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration.

• DIFFUSIVE = False,True sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

3.2.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

3.2.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.
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• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/density to visualize fluid densities.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
density of the Kelvin-Helmholtz instability at the end of the simulation is shown in Fig. 3.2.

Fig. 3.2: Visualization of the density in the Kelvin-Helmholtz Instability example

3.2.6 Further experiments

• Set MHD to True to solve the magnetized Kelvin-Helmholtz instability, which demonstrates USim capabilities
to amplify magnetic fields.

• Set TIME_ORDER to third or fourth to see the effect of increased temporal accuracy on the Kelvin-Helmholtz
instability.

• Set NDIM to 3 to solve the Kelvin-Helmholtz instability in 3D. The increased computational requirements of
such a simulation means that you should enable Run with MPI in the MPI tab under Runtime Options in the Run
Window.
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3.3 Magnetized Ramp Flow (rampFlow.pre)

Keywords:

body fitted grid, MHD, ramp flow, supersonic

3.3.1 Problem description

This simulation shows magnetized flow over a ramp using ideal magnetohydrodynamics. The shock wave leads to
compression of both the fluid and the magnetic field.

This simulation can be performed with a USimBase license.

3.3.2 Creating the run space

The Magnetized Ramp Flow example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Magnetized Ramp Flow and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as described below. After any change
is made, the Save and Process Setup button must be pressed again before a new run may commence.

3.3.3 Input file features

The input file allows the user to set a variety of problem parameters related to the physics, initial conditions, domain
and solver used for the magnetized ramp flow problem.

The following parameters control the physics of the magnetized ramp flow problem:

• THETA controls the angle of attack of the ramp.

• PRESSURE controls the pressure of the inflowing fluid.

• DENSITY controls the density of the inflowing fluid.

• MACH_NUM sets the ratio of the flow velocity to the sound speed (the Mach number) for the inflowing gas.

• BETA controls the ratio of the gas pressure to the magnetic pressure in the inflowing gas.

• GAS_GAMMA sets the adiabatic index (ratio of specific heats) of the fluid.

The following parameters control the dimensionality, domain size and resolution of the simulation:

• NDIM = 2,3 selects whether to run the problem in two- or three-dimensions.

• SCALE sets the resolution of the grid. Large values correspond to higher resolution.

The following parameters control the duration of the simulation and data output:

• TEND sets the end time for the simulation

• NUMDUMPS sets the number of data dumps during the simulation
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• WRITE_RESTART = False,True tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to run the simulation:

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration.

• DIFFUSIVE = False,True sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

3.3.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

3.3.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/density to visualize fluid density.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
density at the end of the simulation is shown in Fig. 3.3.

3.3.6 Further experiments

• You can increase the steepness of the shock by reducing the Mach number (MACH_NUM).

• You can also change the angle of the shock by changing the ramp angle (THETA).

• Set NDIM to 3 to solve the magnetized ramp flow problem in 3D. The increased computational requirements of
such a simulation means that you should enable Run with MPI in the MPI tab under Runtime Options in the Run
Window.

3.4 Rayleigh-Taylor Instability (rtInstability.pre)

Keywords:

hydrodynamics, gravitational force, Rayleigh Taylor Instability
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Fig. 3.3: Visualization of the fluid mass density in the Magnetized Ramp Flow example
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3.4.1 Problem description

This problem demonstrates the Rayleigh-Taylor instability for the case of a heavy fluid on top of a lighter fluid, subject
to a constant gravitational acceleration. The pressure is determined by the conditions of hydrostatic equilibrium. For
the two-dimensional version of the problem setup considered here, we use a domain

(−𝑇𝑅𝐴𝑁𝑆𝐿𝐸𝑁𝐺𝑇𝐻/2,−𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2)× (𝑇𝑅𝐴𝑁𝑆𝐿𝐸𝑁𝐺𝑇𝐻/2, 𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2)

with periodic boundary conditions in the TRANS direction and reflecting wall boundary conditions in the PAR direction.
For the three-dimensional version of the problem setup considered here, we use a domain

(−𝑇𝑅𝐴𝑁𝑆𝐿𝐸𝑁𝐺𝑇𝐻/2,−𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2,−𝑇𝑅𝐴𝑁𝑆𝐿𝐸𝑁𝐺𝑇𝐻/2)×(𝑇𝑅𝐴𝑁𝑆𝐿𝐸𝑁𝐺𝑇𝐻/2, 𝑃𝐴𝑅𝐿𝐸𝑁𝐺𝑇𝐻/2, 𝑇𝑅𝐴𝑁𝑆𝐿𝐸𝑁𝐺𝑇𝐻/2)

with periodic boundary conditions in the TRANS directions and reflecting wall boundary conditions in the PAR direc-
tion. A single mode perturbation is used to seed the instability.

This simulation can be performed with a USimBase license.

3.4.2 Creating the run space

The Rayleigh-Taylor Instability example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Rayleigh-Taylor Instability and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as shown below. After any change is
made, the Save and Process Setup button must be pressed again before a new run may commence.

3.4.3 Input file features

The input file allows the user to set a variety of problem parameters related to the physics, initial conditions, domain
and solver used for the Rayleigh-Taylor instability.

The following parameters control the physics of the Rayleigh-Taylor instability:

• GRAVITY_ACCEL sets the acceleration due to gravity.

• RHO_LIGHT sets the density of the lighter fluid initially at the bottom of the domain.

• RHO_HEAVY sets the density of the heavier fluid initially at the top of the domain.

• GAS_GAMMA sets the adiabatic index (ratio of specific heats) of the fluid.

• PERTURB_AMP sets the strength of the perturbation seeding the instability.

• MHD = False,True selects whether to evolve the problem in the inviscid hydrodynamic limit (MHD = False) or
the ideal magnetohydrodynamic limit (MHD = True).

• BETA controls the ratio of the gas pressure to the magnetic pressure for problems solved in the magnetohydro-
dynamic limit (i.e. when MHD = True). Note that, for strong enough magnetic fields (small enough BETA), the
instability is stabilized.

The following parameters control the dimensionality, domain size and resolution of the simulation:

• NDIM = 2,3 selects whether to run the problem in two-dimensions or three-dimensions.
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• PAR_LENGTH sets the size of the domain in the direction parallel to the gravitational acceleration vector.

• TRANS_LENGTH sets the size of the domain in the direction transverse to the gravitational acceleration vector.

• PAR_ZONES sets the number of zones in the direction parallel to the gravitational acceleration vector.

• TRANS_ZONES sets the number of zones in the direction transverse to the gravitational acceleration vector.

The following parameters the length of the simulation and data output:

• TEND sets the end time for the simulation

• NUMDUMPS sets the number of data dumps during the simulation

• WRITE_RESTART = False,True tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to run the simulation:

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration.

• DIFFUSIVE = False,True sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

3.4.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

3.4.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize button in the left column of buttons.

• Press the “Open” button to begin visualizing.

• To visualize the fluid density, expand the Scalar Data tab and click the check box for fluids/density.

• Drag the slider at the bottom of the visualization window to move through the simulation in time. The fluid
density distribution at the end of the simulation is shown in Fig. 3.4.

3.4.6 Further experiments

• Set MHD to True to solve the magnetized Rayleigh-Taylor instability.

• Set TIME_ORDER to third or fourth to see the effect of increased temporal accuracy on the Rayleigh-Taylor
instability.

• Set NDIM to 3 to solve the Rayleigh-Taylor instability in 3D. The increased computational requirements of
such a simulation means that you should enable Run with MPI in the MPI tab under Runtime Options in the Run
Window.
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Fig. 3.4: Visualization of density in the Rayleigh-Taylor instability example as a color contour plot.
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3.5 Shock Tube (shockTube.pre)

Keywords:

hydrodynamics, magnetohydrodynamics, Riemann problem, shock tube

3.5.1 Problem description

This example computes shock tube problems for both hydrodynamic and magnetized flows. In essence, a shock tube
is a 1D Riemann problem driven by discontinuous left and right states. Here, we provide a range of specific shock
tubes for an ideal gas, including examples due to Einfeldt, Sod, Liska & Wendroff, Brio & Wu and Ryu & Jones.
Further details, including reference solutions can be found in Stone et al. The Astrophysical Journal Supplement
Series, Volume 178, Issue 1, article id. 137-177, pp. (2008).

This simulation can be performed with a USimBase license.

3.5.2 Creating the run space

The Shock Tube example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Shock Tube and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as described below. After any change
is made, the Save and Process Setup button must be pressed again before a new run may commence.

3.5.3 Input file features

The input file allows the user to set a variety of problem parameters related to the physics, initial conditions, domain
and solver used for solving a shock tube problem.

The following parameters control the initial conditions of the shock tube:

• SHOCK_TUBE = EINFELDT1125, EINFELDT1203, SOD, SODLEVEQUE, SODTORO, LISKAWENDROFF,
SLOW, BRIOWU, RYUJONES1a, RYUJONES1b, RYUJONES2a, RYUJONES2b, RYUJONES3a, RYU-
JONES3b, RYUJONES4a, RYUJONES4b, RYUJONES4c, RYUJONES4d selects the initial condition to run.

• REFERENCE_PRESSURE Pressure to scale the solution by in order to set the global sound speed.

• REFERENCE_DENSITY Density to scale the solution by in order to set the global sound speed.

• GAS_GAMMA Adiabatic index, or ratio of specific heats

• MU0 Vacuum permeability

The following parameters control the dimensionality, domain size and resolution of the simulation:

• NDIM = 1,2,3 selects whether to run the problem in one-, two- or three-dimensions.

• PAR_LENGTH sets the size of the domain in the direction parallel to the shock.

• PERP_LENGTH sets the size of the domain in the direction perpendicular to the shock.
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• PAR_ZONES sets the number of zones in the direction parallel to the shock.

• PERP_ZONES sets the number of zones in the direction perpendicular to the shock.

The following parameters the length of the simulation and data output:

• TEND sets the end time for the simulation.

• NUMDUMPS sets the number of data dumps during the simulation

• WRITE_RESTART = False,True tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to evolve the Kelvin-Helmholtz instability:

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration.

• DIFFUSIVE = False,True sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

3.5.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

3.5.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Navigate to the “1-D Fields” Data View

• The visualization opens with four panels consisting of 1D line plots. The quantities are ‘fluids/density’ (mass
density), ‘fluids/pressure’ (thermal pressure), ‘fluids/velocity_0’, ‘fluids/velocity_1’, ‘fluids/velocity_2’ (three
components of the fluid velocity)

• Drag the slider at the bottom of the Visualization Results pane to Dump 10 to see results at the end of the
simulation, as shown in Fig. 3.5.

3.5.6 Further experiments

• Change the adiabatic index of the gas (GAS_GAMMA) to see the effect of the gas having an different equation
of state.

• Change the number of times a sound wave crosses the box (WAVE_CROSSINGS) to see the discontinuities
propagate through the volume.

• Change the initial condition (SHOCK_TUBE) to the classic magnetized Brio & Wu shock tube (SHOCK_TUBE
= BRIOWU).

64 Chapter 3. USimBase Examples



USimQuickStart, Release 3.0.1

Fig. 3.5: Visualization of gas pressure, fluid density and first component of the velocity for the default Shock Tube
example.
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Drag the slider at the bottom of the Visualization Results pane to Dump 10 to see results at the end of the simulation,
as shown in Fig. 3.6.

Fig. 3.6: Visualization of gas pressure, fluid density and velocity for the default Brio & Wu shock tube.

3.6 Unstable Plasma zPinch (zPinch.pre)

Keywords: MHD, ideal plasma instabilities

zPinch

3.6.1 Problem description

The Z-Pinch is an ideal MHD simulation of a cylindrical plasma with a purely axial current and a periodic boundary
condition in the axial direction. This problem uses a top-hat current density profile such that

J =

{︃
𝐽0𝑧 𝑟 ≤ 𝑟𝑝

0 𝑟 > 𝑟𝑝

where 𝑟𝑝 is the current column radius. Thus, the magnetic field is

B =

{︃
− 𝑟

2𝜇0𝐽0𝜃 𝑟 ≤ 𝑟𝑝

− 𝑟2𝑝
2𝑟𝜇0𝐽0𝜃 𝑟 > 𝑟𝑝
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The MHD force balance condition (J×B = ∇𝑝) becomes

𝑑𝑝

𝑑𝑟
+

𝐵𝜃

𝜇0𝑟

𝑑

𝑑𝑟
(𝑟𝐵𝜃) ,

and, thus, the pressure profile is

𝑝 =

{︃
𝜇0𝐽

2
0

4

[︀
(1 + 𝛼) 𝑟2𝑝 − 𝑟2

]︀
𝑟 ≤ 𝑟𝑝

𝜇0𝐽
2
0

4 𝛼𝑟2𝑝 𝑟 > 𝑟𝑝

where 𝛼 sets the base pressure outside the plasma column.

In general, the plasma column may be unstable to perturbations with a wavenumber (k) such that

k =
𝑚

𝑟
𝜃 +

2𝜋𝑛

𝑍
𝑧

where 𝑚 is the azimuthal wavenumber, 𝑛 is the axial wavenumber, and 𝑍 is the axial length of the computational
domain. This example assumes axisymmetry in the azimuthal direction of the cylindrical column, and thus instabilities
with 𝑚 = 0 are modeled. The simulation is initialized with a 𝑛 = 1 perturbation in the magnetic field which leads to
instability with the default parameters.

This simulation can be performed with a USimBase license.

3.6.2 Creating the run space

The Unstable Plasma Z-Pinch example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Unstable Plasma Z-Pinch and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as described below. After any change
is made, the Save and Process Setup button must be pressed again before a new run may commence.

3.6.3 Input file features

The key variables of the input file are exposed in the Setup window. These variables allow one to set the following
fields:

The following parameters control the physics of the Z-Pinch:

• AXIAL_LENGTH - The axial length of the cylinder.

• CURRENT - The axial current in the plasma column (𝐼 = 𝐽0𝜋𝑟
2
𝑝).

• NUM_MODES - Sets the wavenumber

• BASE_PRESSURE_RATIO - The ratio of the pressure and density at the wall to the pressure and density in the
plasma core (𝛼).

• PERTURBATION_AMPLITUDE - The relative amplitude of the perturbed field to the field generated by the
axial current.

• GAS_GAMMA - The ratio of specific heats
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The following parameters control the dimensionality, domain size and resolution of the simulation:

• RADIAL_RESOLUTION - The number of radial grid points.

• AXIAL_RESOLUTION - The number of axial grid points.

The following parameters the length of the simulation and data output:

• TEND sets the end time for the simulation.

• NUMDUMPS sets the number of data dumps during the simulation

• WRITE_RESTART = False,True tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to evolve the Z-Pinch:

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration.

• DIFFUSIVE = False,True sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

3.6.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

3.6.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing. Select a Data View of Field Analysis.

• Select fluids/density from the Field dropdown.

• Click the check box for Log Scale Color Table to view the density using a logarithmic scale.

• Drag the slider at the bottom of the Visualization Results pane to see results for the different simulation data
dumps, as shown in Fig. 3.7.

• Add a corresponding line plot by adjusting settings in the Lineout Settings pane and pressing the Perform Lineout
button to draw.

The plot in Fig. 3.7 was made with the calewhite color scale at time 3 × 10−6 seconds. Here the instability is in the
nonlinear phase, and the plasma density has ruptured out of the initial plasma column.
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Fig. 3.7: Visualization of the mass density in the Unstable Plasma Z-Pinch example

3.6.6 Further experiments

• Run the computation into the deep nonlinear stage at current resolution, then run it again with decreased or
enhanced resolution. Note there is no dissipation in the ideal MHD system so differing results are expected
when dynamics are on the grid-scale length.
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CHAPTER

FOUR

USIMHEDP EXAMPLES

The USimHEDP examples illustrate how to solve complex problems in high energy density plasmas. The USimHEDP
examples can be executed with a USimHEDP license.

4.1 Anisotropic Diffusion (anisotropicDiffusion.pre)

Keywords:

Anisotropic Diffusion

4.1.1 Problem description

This example simulates anisotropic diffusion where the conductivity is high parallel to circular rings and low perpen-
dicular to this rings.

This simulation can be performed with a USimHEDP license.

4.1.2 Creating the run space

The Anisotropic Diffusion example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Anisotropic Diffusion and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.1.3 Input file features

The following parameters can be varied to study different plasmas:

• KPARALLEL - Conductivity in parallel direction

• KPERPENDICULAR - Conductivity in perpendicular direction
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• CFL - Explicit CFL

• CFLSTEP - Super Time Stepping CFL

• TIME_ORDER = first,second,third,fourth sets the order of accuracy for the time-integration

• GRIDFILE - Name of the grid file (anisotropicDiffusion.msh for serial, anisotropicDiffusion2.msh for parallel
run on 2 cores)

• GRIDFORMAT - Format of mesh file (either ExodusII or Gmsh)

• TEND - Simulation end time (seconds)

• NUMDUMPS - Number of data dumps during the simulation

• WRITE_RESTART = False,True - tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

• DIFFUSIVE = False,True - sets whether to use diffusive (but robust!) spatial integration schemes.

• DEBUG = False,True - sets whether to output data for debugging a run. Warning: this will output A LOT of
information!

4.1.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.1.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/pressure to visualize the fluid pressure.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
pressure distribution at the end of the simulation is shown in Fig. 4.1.

4.1.6 Further experiments

• Try varying KPARALLEL. Increasing the value should result in faster diffusion of the transport parameter.

4.2 Anisotropic Poisson (anisotropicPoisson.pre)

Keywords:

iterative, multigrid, Poisson, electrostatics, magnetostatics
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Fig. 4.1: Visualization of fluid pressure for the Anisotropic Diffusion example

4.2.1 Problem description

This example demonstrates the anisotropic Poisson solve that can be used for the electric potential, heat transfer,
magnetic field diffusion, and wherever a Poisson’s equation has to be solved. A source varying in space and time is
considered. The source has a sine wave variation at a frequency of 1 MHz. The coefficients are assumed to be different
in x,y, and z directions. Source is given by s = (6x+12y+18z)*sin(wt). Simulation is performed for a duration of one
cycle. For CX=1, CY=2, and CZ=3, the result would be x^3+y^3+z^3.

This simulation can be performed with a USimHEDP license.

4.2.2 Creating the run space

The Anisotropic Poisson example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Anisotropic Poisson and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.
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4.2.3 Input file features

Primary variables are:

• FREQUENCY - source variation frequency

• CX, CY, CZ - coefficients in the x,y,z directions

• NX, NY, NZ - Number of cells in the x,y,z directions

• NUMDUMPS - Number of data dumps during the simulation

4.2.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.2.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing. The left pane has all of the output variable from the simulation.
Expand the ‘Scalar Data’ field to see ‘fluids/coeff_0..._9’ (tensor of the diffusion coefficients), phi (scalar po-
tential), and rho (source on the right hand side of the Poisson’s equation).

• Select the variable ‘phi’ and drag the slider at the bottom of the Visualization Results pane to the right to see
potential at the positive peak of the source simulation. Check the ‘Display Contour’ option and hold+move the
cursor along the contours to set an orientation as shown in Fig. 4.2.

4.2.6 Further experiments

• Change the resolution of the grid by setting NX, NY, NZ to 64 or 128 to see more refined results.

4.3 Multi-Fluids with Collisions (collisionalMultiFluid.pre)

Keywords:

Multi-Fluid Collisions

4.3.1 Problem description

This problem shows collisions between three (separate) fluid species in a simple shock problem and allows one to
compare it with the single-fluid solution. In the highly collisional regime the multi-fluid problem converges to the
single fluid case.

This simulation can be performed with a USimHEDP license.
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Fig. 4.2: Visualization of the time varying scalar potential
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4.3.2 Creating the run space

The Multi-Fluids with Collisions example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Multi-Fluids with Collisions and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.3.3 Input file features

The following parameters can be varied to look at the effects of collisionality on the shock solution:

• NUMDUMPS - Number of data dumps during the simulation

• XUPPER - Domain size

• PRESSURE - Reference pressure of the gas

• DENSITY - Reference density of the gas

• GAMMA - Gas constant

• PRL - the total pressure on the left half of the domain.

• RHOL - the total density on the left half of the domain.

• PRR - the total pressure on the right half of the domain.

• RHOR - the total density on the right half of the domain.

• FRAC1L - the fraction of gas 1 on the left half initially.

• FRAC2L - the fraction of gas 2 on the left half initially.

• FRAC3L - the fraction of gas 3 on the left half initially.

• FRAC1R - the fraction of gas 1 on the right half initially.

• FRAC2R - the fraction of gas 2 on the right half initially.

• FRAC3R - the fraction of gas 3 on the right half initially.

• MI - Reference mass of ion

• DI - Reference diameter of ion

• MI1 - Mass of ion1

• MI2 - Mass of ion2

• MI3 - Mass of ion3

• DI1 - Diameter of ion1

• DI2 - Diameter of ion2

• DI3 - Diameter of ion3

76 Chapter 4. USimHEDP Examples



USimQuickStart, Release 3.0.1

4.3.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.3.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing. The visualization opens with four panels consisting of 1D line plots.

• Drag the slider at the bottom of the Visualization Results pane to see results at the end of the simulation, as
shown in Fig. ??.

The following values can be visualized

• N1,N2,N3 the number densities for species 1, 2 and 3

• T1,T2,T3 the temperatures for species 1, 2 and 3

• V1_0,V1_1,V1_2 the velocity components for species 1

• V2_0,V2_1,V2_2 the velocity components for species 2

• V3_0,V3_1,V3_2 the velocity components for species 3

• collisionMatrix_0 through collisionMatrix_8 the collisional cross frequencies between species

• q1_0,q1_1,q1_2,q1_3,q1_4 the mass density, momentum density and energy of the first species

• q2_0,q2_1,q2_2,q2_3,q2_4 the mass density, momentum density and energy of the second species

• q3_0,q3_1,q3_2,q3_3,q3_4 the mass density, momentum density and energy of the third species

• qTotal_0,qTotal_1,qTotal_2,qTotal_3,qTotal_4 the mass density, momentum density and energy of the sum of
the 3 species

4.3.6 Further experiments

• Increase RHOL and RHOR by a factor of 10 and the fluids will become much more collisional, producing the
standard sod shock result.

4.4 Dense Plasma Focus (densePlasmaFocus.pre)

Keywords:

Z-pinch, dense plasma focus, MHD, axisymmetric, MPD, two temperature, general equation of state
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Fig. 4.3: Visualization of the densities of each species and the temperature of the first species for the Multi-Fluids
with Collisions example

4.4.1 Problem description

This problem solves a simple dense plasma focus (DPF) using a two-temperature MHD model with a user-specified
equation of state on an unstructured grid in axisymmetric geometry. The dense plasma focus is a fusion concept
envisioned as both a power source, neutron source, and even high-powered propulsion. The DPF is also similar to
other plasma accelerators such as the magneto plasma dynamic (MPD) thruster, in which the plasma is accelerated by
the self field created by the current running through the plasma.

4.4.2 Creating the run space

The Dense Plasma Focus example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Dense Plasma Focus and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.
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4.4.3 Input file features

The input file allows the user to specify the number density of the plasma (N0), the temperature of the plasma (T),
a constant resistivity (ETA), the atomic weight of the plasma species (ATOMIC_WEIGHT), and the current flowing
through the plasma (CURRENT). In addition, many numerical parameters can be set through the input file.

The key variables of the input file are exposed in the “Setup” window. These variables allow one to set the following
fields

• GRIDFILE - Name of the mesh file

• CFL - CFL condition for the simulation

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation

• ATOMIC_WEIGHT - Atomic weight of ion

• ION_TEMP - The temperature of the ions (Kelvin)

• TEMPERATURE_RATIO - Temperature ratio of electrons and ions at the nozzel inlet

• CURRENT - The current flowing through the plasma (Amps)

• N0 - The peak ion number density (number/m^3)

• OHMIC_RESISTIVITY - The resistivity of the plasma (constant Ohm Meters)

• NUMERICAL_FLUX - specifies the Riemann solver used to calculate an upwind approximation to the flux
tensor. For hydrodynamic problems, options include localLaxFlux, hlleFlux, hllcEulerFlux. For magnetohy-
drodynamic problems, options include localLaxFlux, hlleFlux, hlldMhdFlux, fWaveFlux. For more general
systems, options include localLaxFlux, hlleFlux, fWaveFlux.

• TIME_ORDER=first,second,third,fourth - sets the order of accuracy for the time-integration.

• LIMITER=muscl,minmod,none - specifices the spatial limiting method used in reconstructing primary variables
to use to ensure that method remains total value diminishing (TVD).

• VARIABLE_FORM - Limit in primitive or conservative variables

4.4.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.4.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/q_0 to visualize the mass density of the plasma.
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• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
results near the end of the simulation are shown in Fig. 4.4.

Fig. 4.4: Visualization of mass density in the Dense Plasma Focus example

4.4.6 Further experiments

Two ExodusII format mesh files are included with this example. The default file choice is “dpf.g”, which is a mesh
partitioned for serial execution. Additional meshes (dpf.g.2.*, dpf.g.4.*, dpf.g.8.*) are included for 2, 4, and 8 core
runs, respectively. Unlike GMSH meshes, it is not necessary to specify the number of cores that the mesh is partioned
onto; USim looks for the appropriate files automatically. To run the example using the 2-core mesh, proceed as
follows:

• Return to the Run window by pressing the Run icon in the workflow panel.

• In the Run window, press the MPI tab in the Runtime Options pane.

• Check the box marked Run with MPI and set Number of Cores equal to 2.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane. You
will again see the engine output in the Logs and Output Files pane‘.

After the simulation has executed, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Geometries in the Visualization Controls pane and click the checkbox for fluids/domain to visualize
simulation geometry.

• Expand Scalar Data and click the check box for fluids/q_0 to visualize fluid densities.
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• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time.

We can run further experiments on the dense plasma focus. For example, we can explore the effect of increasing the
current (CURRENT) or decreasing the number density (N0). In the latter case, the plasma should move faster.

4.5 Gas Injection (gasInjection.pre)

Keywords:

hydrodynamics, vacuum, boundary

4.5.1 Problem description

This problem not only demonstrates the time-dependent boundary condition capabilities in USim, but also the ability
to handle extremely strong shocks in 3 dimensions. In this case, the injected fluid is 6 orders of magnitude more dense
than the background gas.

4.5.2 Creating the run space

The Gas Injection example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimBase: Basic Physics Capabilities.

• Select Gas Injection and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.5.3 Input file features

The input file allows the user to set the jet pressure (PRESSURE), the jet mass density (RHO), the jet flow velocity
(U), the cfl number (CFL), the end time (TEND), and the number of data dumps (NUMDUMPS).

Primary variables are:

• PRESSURE - Pressure in Jet.

• RHO - Mass density of jet.

• U - Velocity of jet.

• CFL - CFL number.

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation
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4.5.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.5.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• To visualize the fluid density, expand the Scalar Data tab and click the check box for fluids/q_0.

• Click the check box for Display Contours.

• Use the mouse to rotate the image within the Visualization Results pane.

• Drag the slider at the bottom of the visualization window to move through the simulation in time. The mass
density distribution at the end of the simulation is shown in Fig. 4.5.

Note that 𝑞0 is mass density, 𝑞1, 𝑞2, and 𝑞3 are the three components of momentum density, and 𝑞4 is energy density.

4.5.6 Further experiments

• Set U to 100.0 and increase TEND by a factor of 10 to see the effect of mach number on jet expansion.

4.6 Two-Fluid Magnetic Reconnection (gemChallenge.pre)

Keywords:

GEM Challenge, fast reconnection, two-fluid, hall effect, electron inertia, electromagnetic

4.6.1 Problem description

This problem shows fast magnetic reconnection based on initial conditions from the GEM challenge magnetic recon-
nection problem. The model used is fully electromagnetic, two-fluid with semi-implicit time stepping to step over the
plasma and cyclotron frequency. This approach shows significant speedup for problems where the cyclotron or plasma
frequency dominates the time step.

4.6.2 Creating the run space

The Two-Fluid Magnetic Reconnection example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Two-Fluid Magnetic Reconnection and press the Choose button.
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Fig. 4.5: Visualization of the density in the Gas Injection Example as a color contour plot
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• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.6.3 Input file features

In the standard GEM challenge problem the initial conditions are set up in non-dimensional form. In this case we
mimic this scenario by setting coefficients such as ion charge and permeability to 1.0 and then ensure that the ion
thermal velocity is approximately 0.01c. A realistic electron to proton mass ratio is maintained. Divergence cleaning
for the magnetic field is performed using the hyperbolic approach and Poisson equation is preserved using electric
field diffusion.

In this simulation reconnected magnetic flux is stored using a dynVector. The reconnected flux is then one-half the
integral of the absolute value of By along y=0. This reconnected flux can be compared with published results, though
it will typically only converge to those results at high resolution. If possible, increase the resolution and run the
simulation in parallel.

The key variables of the input file are exposed in the “Setup” window. These variables allow one to set the following
fields

• CFL - CFL condition for the simulation

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation

• SPECIES_CHARGE - Charge of the positive species.

• ION_MASS - Mass of the ion.

• ELECTRON_MASS - Mass of the electron.

• GAS_GAMMA - Specific heat ratio of the electron and ion fluid

• N0 - The peak ion number density

• LAMBDA - The current layer thicknesss

• B0 - The X magnetic field at infinity

• PERTURBATION_FACTOR - The factor that B0 is multiplied by to define the size of the perturbation

• SPEED_OF_LIGHT - Speed of light

• EPSILON0 - Permeability of free space

• BP - Magnetic correction potential field divergence correction speed factor. The correction speed is given by
speed=BP*c so the value BP should be near 1.0 .

• FLUID_NUMERICAL_FLUX - specifies the Riemann solver used to calculate an upwind approximation to the
flux tensor. For hydrodynamic problems, options include localLaxFlux, hlleFlux, hllcEulerFlux. For magneto-
hydrodynamic problems, options include localLaxFlux, hlleFlux, hlldMhdFlux, fWaveFlux. For more general
systems, options include localLaxFlux, hlleFlux, fWaveFlux.

• EM_NUMERICAL_FLUX - specifies the Riemann solver used to calculate an upwind approximation to the flux
tensor. For hydrodynamic problems, options include localLaxFlux, hlleFlux, hllcEulerFlux. For magnetohy-
drodynamic problems, options include localLaxFlux, hlleFlux, hlldMhdFlux, fWaveFlux. For more general
systems, options include localLaxFlux, hlleFlux, fWaveFlux.

• TIME_ORDER=first,second,third,fourth - sets the order of accuracy for the time-integration.
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• LIMITER=muscl,minmod,none - specifices the spatial limiting method used in reconstructing primary variables
to use to ensure that method remains total value diminishing (TVD).

• NX - Number of cells in the x direction

• NY - Number of cells in the y direction

• NZ - Number of cells in the z direction (3D only)

• X_MIN - lower X position of grid

• X_MAX - upper X position of grid

• Y_MIN - lower Y position of grid

• Y_MAX - upper Y position of grid

• Z_MIN - lower Z position of grid (only in 3D)

• Z_MAX - upper Z position of grid (only in 3D)

4.6.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.6.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• In the Data View dropdown menu, select History. The history field will provide you with access to dynVectors,
in this case the reconnected flux. Plot 0 selects integratedFlux. The image below shows the result of a complete
simulation Fig. 4.6.

4.6.6 Further experiments

• Decreasing the plasma layer thickness (LAMBDA) increases the initial reconnection rate.

• Decreasing the SPECIES_CHARGE reduces the magnetization (by increasing the Larmor radius of the electrons
and ions) and prevents the magnetic field from maintaining equilibrium. Increasing the SPECIES_CHARGE
does the opposite, the field is tied more closely to the plasma. Fast reconnection can occur in this case. However,
it likely requires much higher resolution to effectively resolve the reconnection layer.

4.7 Magnetic Nozzle (magneticNozzle.pre)

Keywords:

Magnetic nozzle, Gas dynamic MHD
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Fig. 4.6: Visualization of the integratedFlux history in the Two-Fluid Magnetic Reconnection example

4.7.1 Problem description

This example simulates the plasma acceleration in a magnetic nozzle used in micro vacuum arc thrusters to improve
the performance. The magnetic field lines are generated using current coils placed around a cylinder. The magnetic
field lines form a virtual nozzle for incoming plasma. Incoming plasma is generated from the arc discharge. The
simulation is demonstrated using two dimensional domain though axi-symmetric is preferred. External magnetic
field is generated using wire field equation. The flow is simulated using gasDynamicMhd equations(refer to USim
reference manual). Arc is not simulated, instead constant number density, velocity, ionization number, and electron
ion temperature ratio at the erosion surface are given as inputs.

This simulation can be performed with a USimHEDP license.

4.7.2 Creating the run space

The Magnetic Nozzle example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Magnetic Nozzle and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

86 Chapter 4. USimHEDP Examples



USimQuickStart, Release 3.0.1

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.7.3 Input file features

The following parameters can be varied to study different plasmas:

• GRIDFILE - grid file name

• CFL - CFL condition for the simulation

• ATOMIC_WEIGHT - Atomic weight of ions

• ION_GAMMA - Specific heat ratio ions

• ELECTRON_GAMMA - Specific heat ratio of electrons

• N0 - Initial number density of ions

• ION_TEMP - Temperature of Ions at the nozzle inlet

• TEMPERATURE_RATIO - Temperature ratio of electrons and ions at the nozzle inlet

• Z_RATIO - Average change number of ions

• COIL_DIAMETER_RATIO - Ratio of the diamter of current coil to the diamter of the thurster cylinder

• COIL_CURRENT - Coil current to generate magnetic field

• V_IN - Inlet velocity of the plasma x-component

• U_IN - Inlet velocity of the plasma y-component

• INLET_NUMBER_DENSITY - Number density of ions at the nozzle inlet

• RESISTIVITY - Resistivity of plasma

• TSTART - Simulation start time (seconds).

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation

4.7.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.7.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/qMod_0 to visualize the ion density.
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• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The fluid
density distribution at the end of the simulation is shown in Fig. 4.7.

Similarly other parameters such as magnetic field can be visualized. The description of output parameters follows

• E_0,E_1,E_2 electric field

• J_0,J_1,J_2 total current

• Z ionization number

• backgroundB_0,backgroundB_1,backgroundB_2 magnetic field induced by wire

• eta resistivity

• nDens_0 number density of ions

• nDens_1 number density of electrons

• qMod_0 mass density of ions

• qMod_1,qMod_2,qMod_3 momentum components

• qMod_4 ion energy density

• qMod_5,qMod_6,qMod_7 magnetic field components

• qMod_9 electron energy density

Fig. 4.7: Visualization of ion density for the Magnetic Nozzle example.

4.7.6 Further experiments

• Type of plasma can easily be changed by choosing the appropriate ATOMIC_WEIGHT.
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• The effect of variation in arc current can be simulated by changing‘INLET_NUMBER_DENSITY‘ and/or V_IN.
For example, increase the INLET_NUMBER_DENSITY and V_IN by 100%.

• The plasma jet focus can be adjusted by varying the COIL_DIAMETER_RATIO and COIL_CURRENT. Note
that in this demo, the coil is actually a wire and coil diameter is distance between the wires. For instance,
increase the COIL_DIAMETER_RATIO and/or COIL_CURRENT up to 100%.

• Try running in parallel on 2 cores by changing the grid to magneticNozzle2.msh

4.8 Merging Plasma Jets (plasmaJetMerging.pre)

Keywords:

Plasma Liner Experiment, plasma jet merging, radiation, fusion

4.8.1 Problem description

This problems shows plasma jet merging as investigated for the Los Alamos Plasma Liner Experiment by HyperV
technologies. An ideal MHD model with general equation of state and bremsstrahlung radiation is used along with the
plasma jet updater. By modifying the input file an arbitrary number of plasma jets can be included at arbitrary angles
with respect to each other.

4.8.2 Creating the run space

The Merging Plasma Jets example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Merging Plasma Jets and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window as shown below. After any change is
made, the Save and Process Setup button must be pressed again before a new run may commence.

4.8.3 Input file features

The following parameters can be modified to look at the effect on plasma jet merging:

• DIM - Dimension of the simulation (2 or 3)

• T_EV - Plasma temperature in electron volts

• N0 - Peak jet density in number per meter cubed

• AR - Ion species atomic mass

• U - Jet velocity towards the origin

• B0 - Uniform initial magnetic field in the Z direction

• BX - Uniform initial magnetic field in the X direction
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• GAMMA - Specific heat ratio of plasma

• JET_INIT_LENGTH - Length of the region to initialize the jet.

• JET_INIT_WIDTH - Width of the region to initialize the jet.

• JET_DENSITY_FUNCTION - Function that hape of the jet as a function of parallel (x) and perpendicular (r)
directions

• RAD - Distance from the origin of the start of each plasma jet

• CFL - CFL condition for the simulation

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation

• PRESSURE_FACTOR - Vacuum pressure factor which is the ratio of background pressure to peak initial pressure

• DENSITY_FACTOR - Vacuum density factor which is the ratio of background density to peak initial density

• CORRECTION_SPEED - Magnetic field divergence correction speed. Should be on the order of the fastest
MHD wave speed in the simulation.

• NUMERICAL_FLUX - specifies the Riemann solver used to calculate an upwind approximation to the flux
tensor. For hydrodynamic problems, options include localLaxFlux, hlleFlux, hllcEulerFlux. For magnetohy-
drodynamic problems, options include localLaxFlux, hlleFlux, hlldMhdFlux, fWaveFlux. For more general
systems, options include localLaxFlux, hlleFlux, fWaveFlux.

• TIME_ORDER - first,second,third,fourth sets the order of accuracy for the time-integration.

• LIMITER - muscl,minmod,none specifices the spatial limiting method used in reconstructing primary variables
to use to ensure that method remains total value diminishing (TVD).

• NX - Number of cells in the x direction

• NY - Number of cells in the y direction

• NZ - Number of cells in the z direction (3D only)

• X_MIN - lower X position of grid

• X_MAX - upper X position of grid

• Y_MIN - lower Y position of grid

• Y_MAX - upper Y position of grid

• Z_MIN - lower Z position of grid (only in 3D)

• Z_MAX - upper Z position of grid (only in 3D)

4.8.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”
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4.8.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/density to visualize fluid densities.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The fluid
density distribution is early on in the simulation is shown in Fig. 4.8.

Fig. 4.8: Visualization of density in Merging Plasma Jets Merging example

4.8.6 Further experiments

• The default simulation has the background magnetic field set to 0. Set the background magnetic field B0=0.01
and run the simulation again. By visualizing 𝑞7 in the visualization window you will be able to see the compres-
sion of the Z magnetic field from the incoming jets.

• We typically run these simulations with a background density factor of about 1 × 10−6 the initial peak density
to simulate the vacuum. If this value is raised significantly by, for example, increasing DENSITY_FACTOR to
1× 10−1, you will see the jets plow into the background fluid, illustrating why it is important to maintain a low
background density for these types of problems.

4.8. Merging Plasma Jets (plasmaJetMerging.pre) 91



USimQuickStart, Release 3.0.1

4.9 Ten-Moment, Two-Fluid Shock (tenMomentShock.pre)

Keywords:

Ten Moment Two-Fluid

4.9.1 Problem description

This example simulates a two-fluid shock where the ions use the 10 moment plasma model and the electrons use the 5
moment model.

This simulation can be performed with a USimHEDP license.

4.9.2 Creating the run space

The Ten-Moment, Two-Fluid Shock example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Ten-Moment, Two-Fluid Shock and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.9.3 Input file features

The following parameters can be varied to study different plasmas:

• CFL - used in the simulation

• SCALE - scales the density and pressure keeping the temperature and acoustic speed constant

• NCELLS - number of cells in the simulation

• TEND - final simulation time

• NUMDUMPS - number of data dumps during the simulation

• XMAX - size of the domain

4.9.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”
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4.9.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• In the Data View dropdown menu, select 1-D Fields.

• The electron density shown in Fig. 4.9 can be visualized by clicking on electrons_0 in Plot 0.

Similarly other parameters such as magnetic field can be visualized. The description of output parameters follows

• electrons_0 through electrons_4 the electron density, momentum density and energy density

• ions_0 through ions_9 the ion density, momentum density and 6 components of anisotropic energy density

• em_0 through em_5 are the E and B fields

Fig. 4.9: Visualization of electron mass density for the Ten-Moment, Two-Fluid Shock example.

4.9.6 Further experiments

1. Increase XMAX and TEND by the same factor to see how the solution evolves. Unlike the Euler equations and ideal
MHD, the solution is not invariant with the scale of the system.
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4.10 Verify EOS Table (verifyEOSTable.pre)

Keywords:

Equation-of-state table

4.10.1 Problem description

This example verifies the result of interpolation and inverse interpolation from a SESAME equation-of-state (EOS)
table. Fake data is provided for the purpose of this example. To use this example with the PROPACEOS reader, simply
set INPUTFORMAT to 1. This replaces instances of refmanual-sesameVariables with refmanual-propaceosVariables
and replaces 301energy and 301pressure with Eint and Ptot in the operations strings, respectively.

In this example, a logarithmic grid is configured that provides the initial values for temperature and density. The
energy and pressure tables are evaluated and subsequently inverse operations are applied to recompute the density and
temperature. There are four inverse operations, two for each of the energy and pressure tables. The relative difference
of the inverse and initial densities and temperature are computed and should be accurate to machine precision in
regions of interest.

This test can be performed with a USimHEDP license.

4.10.2 Creating the run space

The verify EOS Table example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHEDP: High Energy Density Plasmas.

• Select Verify EOS Table and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

4.10.3 Input file features

The following parameters can be varied to verify different EOS tables:

• TMIN - minimum temperature to check

• TMAX - maximum temperature to check

• NMIN - minimum mass density to check

• NMAX - maximum mass density to check

• EOSFILE - EOS table file name

• MATID - Material ID - required for SESAME only

• SPECIESMASS - Species mass - required for PROPACEOS only

• INPUTFORMAT - Input format - SESAME=0, PROPACEOS=1

94 Chapter 4. USimHEDP Examples



USimQuickStart, Release 3.0.1

4.10.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

4.10.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/relativeDifference_0 to visualize the relative difference
between the initial density and density computed from the inverse of the pressure EOS table as shown in Fig.
4.10.

• Check the other fluids/relativeDifference_X quantities 1-3 which correspond to the density from the inverse of
the energy EOS table and the temperature from the inverse of the pressure and energy EOS tables, respectively.

The description of output parameters follows:

• density - initial density

• temperature - initial temperature

• energy - Energy computed from interpolation of the EOS table

• pressure - Pressure computed from interpolation of the EOS table

• densityFromPressure - Density computed through inverse interpolation of the EOS pressure table

• densityFromEnergy - Density computed through inverse interpolation of the EOS energy table

• temperatureFromPressure - Temperature computed through inverse interpolation of the EOS pressure table

• temperatureFromEnergy - Temperature computed through inverse interpolation of the EOS energy table

• relativeDifference - Quantities correspond to the relative difference of the initial and density from the inverse of
the pressure and energy EOS tables and the temperature from the inverse of the pressure and energy EOS tables,
respectively.

4.10.6 Further experiments

• Change the material ID to check different materials

• Change the input file name to check different files

• When tables are not monotonic functions of density and temperature, note that incorrect results are expected.
Ensure that the region of interest for computation produces valid results for the respective inverse operations
that are used.
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Fig. 4.10: Visualization of the relative difference between the initial density and density computed from the inverse
of the pressure EOS table.
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CHAPTER

FIVE

USIMHS EXAMPLES

The USimHS examples illustrate how to solve problems for hypersonic flight. The USimHS examples can be executed
with a USimHS license.

5.1 Diffusion (diffusion.pre)

Keywords:

diffusion, conduction

5.1.1 Problem description

This example models thermal diffusion from a cylindrical wall held at constant temperature. The diffusion scheme
here can be used for all types of diffusion including thermal and species diffusion. This example uses the super time
stepping integrator which accelerates the solution of diffusion type systems compared to standard explicit approaches.

This simulation can be performed with USimHS and USimHEDP license.

5.1.2 Creating the run space

The Diffusion example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHS: Hypersonics.

• Select Diffusion and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

5.1.3 Input file features

The input folder has externally generate mesh file using Gmsh. The following parameters can be varied to simulate
different flow regimes.

• GRIDFILE - Name of grid file
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• NUMDUMPS - Number of data dumps during the simulation

• EXPLICIT_CFL - the explicit CFL to use to compute the number of STS cycles

• STS_CFL - the actual CFL

• USESTS - is 1 if the STS method is used 0 if the standard explicit approach should be used

5.1.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

5.1.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/q to get the temperature distribution.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
temperature distribution at the end of the simulation is shown in Fig. 5.1.

5.1.6 Further experiments

• Switch USESTS to 0 to see how much slower the simulation runs when standard explicit methods are used.

• Increase STS_CFL to see how the solution changes as larger and larger time steps are used.

5.2 Turbulent Flow Over Flat Plate (flatPlate.pre)

Keywords:

hydrodynamics, turbulence, Reynolds-Average Navier Stokes models

5.2.1 Problem description

This problem demonstrates boundary layer formation for subsonic flow over a flat plate, based on the problem de-
scribed at http://turbmodels.larc.nasa.gov/flatplate.html. Two choices of Reynolds-Averaged Navier Stokes turbulence
models are available: the Chien kEpsilon model described at http://turbmodels.larc.nasa.gov/ke-chien.html and the
kOmega SST model described at http://turbmodels.larc.nasa.gov/sst.html.

This simulation can be performed with a USimHS license.
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Fig. 5.1: Visualization of thermal diffusion.
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5.2.2 Creating the run space

The Flat Plate example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHS: Hypersonics.

• Select Flow over Flat Plate and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

5.2.3 Input file features

The input file allows the user to set a variety of problem parameters related to the physics, initial conditions, domain
and solver used for boundary layer formation for subsonic flow over a flat plate.

The following parameters control the simulation physics:

• USE_KEPSILON = True,False - selects whether to evolve the problem using the Chien kEpsilon model
(USE_KEPSILON = True) or the kOmega SST model (USE_KEPSILON = False).

• MACH_NUM - sets the ratio of the flow velocity to the sound speed (the Mach number).

• T_ATM - sets the flow temperature in Kelvin.

• P_ATM - sets the flow pressure in Pascals.

• TURBULENT_INTENSITY - sets the intensity of turbulent fluctuations captured by RANS Model.

• TURBULENT_REYNOLDS_NUMBER - is a dimensionless parameter describing ratio of turbulent viscosity to
characteristic length scale.

• GAS_GAMMA - sets the adiabatic index (ratio of specific heats) of the fluid.

The following parameters control the dimensionality, domain size and resolution of the simulation:

• VERTICAL_ZONES - sets the number of zones in the direction perpendicular to the flow.

• VERTICAL_SIZE - sets the size of the domain in the direction perpendicular to the flow.

The following parameters the length of the simulation and data output:

• TEND - sets the end time for the simulation.

• NUMDUMPS - sets the number of data dumps during the simulation

• WRITE_RESTART = False,True - tells USim to output data necessary to restart the simulation. If this parameter
is set to False then the Restart at Dump Number functionality in the Standard tab under Runtime Options in the
Run window will not be available.

The following parameters control the USim solvers used to evolve the problem:

• HYPERBOLIC_TIME_ORDER = first,second,third,fourth - sets the order of accuracy for the hyperbolic system
time-integrator.

• DIFFUSION_TIME_ORDER = first,second - sets the order of accuracy for the diffusion system time-integrator.

• DEBUG = False,True - sets whether to output data for debugging a run. Warning: this will output A LOT of
information!
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5.2.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

5.2.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize button in the left column of buttons.

• Press the “Open” button to begin visualizing.

• To visualize the fluid density, expand the Scalar Data tab and click the check box for fluids/velocity.

• Drag the slider at the bottom of the visualization window to move through the simulation in time. The velocity
distribution at the end of the simulation is shown in Fig. 5.2.

Fig. 5.2: Visualization of the flow velocity flow over a flat plate as a color contour plot.

5.2.6 Further experiments

• Set USE_KEPSILON to False to use the KOmega SST RANS turbulence model.
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• Increase VERTICAL_ZONES to study convergence of the boundary layer properties.

5.3 Flow over a Cylindrical Rod (highSpeedRod.pre)

Keywords:

Cylindrical Rod at Sea Level, hypersonic flow, Reactive flow, highSpeedRod

5.3.1 Problem description

This problem demonstrates aerothermal heating of a cylindrical body moving at Mach 23. The air surrounding the
shock regions dissociates and ionizes. This simulation considers 7 species air chemistry model and simulates the flow
at sea level. Viscous and conductive terms appropriate for a Sutherland viscosity model are implemented and are
accelerated using Super Time Stepping techniques.

This simulation can be performed with a USimHS license.

5.3.2 Creating the run space

The Flow over a Cylindrical Rod example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHS: Hypersonics.

• Select Flow over a Cylindrical Rod and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

5.3.3 Input file features

The input file allows the user to set problem parameters. They are:

• FREESTREAM_DENSITY - free stream density

• FREESTREAM_TEMPERATURE - free stream temperature

• MACH_NUM - flow mach number

• NUMDUMPS - number of data dumps during the simulation

• GRIDFILE - mesh file for the simulation

The default choices for the free stream density and temperature are appropriate for sea level.
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5.3.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

5.3.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/qSpecies_6 to get the number density of the electrons.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
results at the end of the simulation is shown in Fig. 5.3.

The following parameters can also be visualized.

• cond Thermal conductivity

• pressure averagepressure of the mixture

• qSpecies_0 - qSpecies_6 number densities of the electrons

• q_0 mass density

• q_1,q_2,q_3 momentum components

• q_4 energy density

• temperature average temperature of the mixture

• velocity_0,velocity_1,velocity_2 three components of velocity

• visc Fluid (Sutherland) viscosity

Species indices are 0 to 6 (N2,N,O2,O,NO,NO+,e).

5.3.6 Further experiments

Four Gmsh fomat mesh files are included with this example, the default (highSpeedRod.msh), which is a low-resolution
mesh that is partitioned for serial execution, versions of this mesh that is partioned so that it can be run with 2
(highSpeedRod2.msh), 4 (highSpeedRod4.msh) or 8 ((‘highSpeedRod8.msh) cores along with a high resolution mesh
that is partioned for either two (highSpeedRodHghRes2core.msh) or 24 (highSpeedRodHghRes24core.msh) cores. To
run the example using this moderate resolution mesh on 2 cores, proceed as follows:

• Return to the “Setup” window by pressing the Setup button in the left column of buttons.

• Enter the mesh file name highSpeedRod2.msh next to meshFile.

• Press the Save And Process Setup button in the upper right corner.

• Proceed to the run window as instructed by pressing the Run button in the left column of buttons.

• In the “Run” window, press the MPI button in the left pane.
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Fig. 5.3: Visualization of the electrons density for the Flow over a Cylindrical Rod example

104 Chapter 5. USimHS Examples



USimQuickStart, Release 3.0.1

• Check the box marked Run with MPI and set Number of Cores equal to 2 as pictured in Fig. 5.4.

Fig. 5.4: Run window showing the parallel option.

After setting the Number of Cores, run the simulation:

• To run the file, click on the Run button in the upper right corner. of the window. You will see the output of the
run in the right pane. The run has completed when you see the output, “Engine completed successfully.”

After the simulation has executed, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize button in the left column of buttons.

• Press the “Open” button to begin visualizing.

• To visualize the geometry, expand the geometry tab and click the checkbox for fluids/domain.

• To visualize the electron density, expand the Scalar Data tab and click the check box for fluids/qSpecies_6.

• Drag the slider at the bottom of the visualization window to move through the simulation in time.

5.4 Supersonic Crossflow over a Cylinder (mach2Cylinder.pre)

Keywords:

Flow over cylinder, Supersonic, Navier-Stokes
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5.4.1 Problem description

This simulation shows the supersonic flow over a cylinder. The formation of bow shock and the final steady wake
can be seen in this laminar flow simulation. Full Navier-Stokes equations are used. Laminar flow assumption is
used. Unstructured grid is used here. This grid was generated using gmsh. The convective and viscous parts are
fully decoupled i.e the flow can be changed to inviscid by removing the viscous terms from the integration Updater.
The properties of the fluid varying with temperature are computed within the input file. In this example, Sutherland’s
formulas are used to obtain viscosity and thermal conductivity. The specific heats are assumed constant. Note that, the
grid used in demonstrating this example is way coarse to display initial vortex shedding.

This simulation can be performed using USimHS license.

5.4.2 Creating the run space

The Supersonic Crossflow over a Cylinder example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHS: Hypersonics.

• Select Supersonic Crossflow over a Cylinder and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

5.4.3 Input file features

The following parameters can be varied:

• CFL - CFL condition for the simulation

• ATOMIC_MASS - Atomic mass of the gas

• GAS_GAMMA - Specific heat ratio of the gas

• RHO0 - Free stream density of the gas

• P0 - Free stream pressure of the gas

• U0 - Free stream velocity of the gas x-component

• V0 - Free stream velocity of the gas y-component

• SURFACE_TEMP - Surface temperature of the body

• CHARACTERISTIC_LENGTH - Characteristic length of the body

• MU_REF - Dynamic viscosity of the free stream gas

• SUTHERLAND - Sutherland coefficient

• TEMP_REF - Reference temperature in Sutherland’s formula

• TSTART - Simulation start time (seconds).

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation
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• GRIDFILE - Name of grid file

• DECOMPOSE - Type true for triangle and tetrahedral, false for 1d, quadrilateral and hexahedral

• CYLINDER_RADIUS - Radius of the cylinder

• X_MIN - Bottom left x-coordinate of the grid

• Y_MIN - Bottom left y-coordinate of the grid

• X_MAX - Top right x-coordinate of the grid

• Y_MAX - Top right y-coordinate of the grid

Note that the input file comes with an externally generated unstructured mesh using Gmsh. The parameters CYLIN-
DER_RADIUS, (X_MIN,Y_MIN), and (X_MAX,Y_MAX) can be changed to accommodate a new mesh generated using
Gmsh. The cylinder’s center is at origin.

5.4.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

5.4.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Geometries in the Visualization Controls pane and click the checkbox for fluids/domain to visualize
simulation geometry.

• Expand Scalar Data and click the check box for fluids/temperature to visualize the temperature distribution.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The final
distribution is shown in Fig. 5.5.

The conservative parameters density, three components of momentum, and energy can also be visualized using
q_0,q_1,..,q_5 respectively. source_0 to source_3 represent the viscous sources of momentum and energy equations.

5.4.6 Further experiments

• Change the flow speed: For example increase U0 to 13600 (Mach 4) keeping the other flow parameters un-
changed. Follow the steps and complete the simulation. The rise in shock temperature can be observed from the
temperature distribution in the visualization window.

• Parallel: In the current version of USim, pre-partitioned unstructured mesh has to be used to run in par-
allel. The input file folder has partitioned mesh files for 2, 4, and 8 cores. (mach2CylinderQuad2.msh,
mach2CylinderQuad4.msh, mach2CylinderQuad8.msh).
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Fig. 5.5: Visualization of temperature distribution in the Supersonic Crossflow over a Cylinder example
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5.5 Blunt-Body Reentry Vehicle (ramC.pre)

Keywords:

RAMC, hypersonic flow, reactive flow, mass injection, cylindrical, Navier-Stokes

5.5.1 Problem description

Reentry of RAMC-type module is simulated. The aerothermal heating due the formation of shock wave and the
resulting weakly ionized plasma are simulated at an altitude of 61 km. Navier-Stokes equations are used for flow
simulation. Thermophysical properties of air are computed internally using kinetic theory. This simulation is carried
out for zero angle of attack and hence axi-symmetric form of equations are used. 7 species air chemistry model is
used to obtain the species densities. Given distribution of temperature along with mass injection can be specified on
the surface. Na, Ca, and K are injected. Ca and Na are injected in the nose cap region. K and Na are injected from the
lateral surface. This simulation considers 10 species in total.

This simulation can be performed with USimHS license.

5.5.2 Creating the run space

The ramC example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHS: Hypersonics.

• Select ramC and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

5.5.3 Input file features

The input folder has externally generate mesh file using Cubit. The following parameters can be varied to simulate
different flow regimes.

• TSTART - Simulation start time (seconds).

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation

• GRIDFILE - name of grid file

• REACTIONS_ATOMIC_DATA - name of the file containing reactions and atomic data

• W0 - z-component of free stream velocity

• FREESTREAM_DENSITY - free stream density

• FREESTREAM_TEMPERATURE - free stream temperature

• SURFACE_TEMPERATURE - surface temperature

• INJECTION_DENSITY1 - density at injection boundary1
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• INJECTION_VELOCITY1 - X component velocity at injection boundary1

• MWinj1_1 - molecular weight of species 1

• MWinj1_2 - molecular weight of species 2

• MFinj1_1 - mass fraction of species 1

• MFinj1_2 - mass fraction of species 2

• INJECTION_DENSITY2 - density at injection boundary2

• INJECTION_VELOCITY2 - X component velocity at injection boundary2

• MWinj2_1 - molecular weight of species 1

• MWinj2_2 - molecular weight of species 2

• MFinj2_1 - mass fraction of species 1

• MFinj2_2 - mass fraction of species 2

• NUMERICAL_FLUX - specifies the Riemann solver used to calculate an upwind approximation to the flux
tensor. For hydrodynamic problems, options include localLaxFlux, hlleFlux, hllcEulerFlux. For magnetohy-
drodynamic problems, options include localLaxFlux, hlleFlux, hlldMhdFlux, fWaveFlux. For more general
systems, options include localLaxFlux, hlleFlux, fWaveFlux.

• TIME_ORDER=first,second,third,fourth - sets the order of accuracy for the time-integration.

• CFL_CONVECTIVE - CFL condition number for convective terms

• VISCOUS_DIFF_TIMESTEP_FACTOR - Factor to further decrease the internally computed time step based on
kinematic viscosity

• THERMAL_DIFF_TIMESTEP_FACTOR - Factor to further decrease the internally computed time step based
on thermal diffusicity

• BASEMENT_TEMPERATURE - least possible temperature in the domain (K).

Note: More information about the format of the file containing the reactions and atomic data can be found in the
reference manual at refmanual-SpeciesDataFile.

5.5.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

5.5.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/q_0 to visualize the density distribution.
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• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The fluid
density distribution at the end of the simulation is shown in Fig. 5.6.

The following parameters can also be visualized:

• a speed of sound

• mwAvg average molecular weight of gas mixture (molecular weight varies due to the change in composition of
gas)

• cpR_0 - cpR_9 constant pressure specific heat of species

• cpAvg average specific heat of fluid

• gammaAvg specific heat ratio of fluid

• p total pressure

• pe electron pressure

• ph heavy particle pressure

• q_0 mass density

• q_1,q_2,q_3 momentum components

• q_4 energy density

• speciesDens_0 - speciesDens_9 number densities of the species

• temperature average temperature of the mixture

• velocity_0,velocity_1,velocity_2 three components of velocity

Species indices are 0 to 6 (N2,N,O2,O,NO,NO+,e,Ca,Na,K).

5.5.6 Further experiments

• The freestream velocity W0 may be changed to simulate different Mach numbers at a given altitude. Increase in
electron density as a result of increased aerothermal heating can be noticed.

• The freestream temperature and density can be changed to simulate the changes in altitude. Lets say at 50 km
altitude, the density and temperature of air are 0.000978 𝑘𝑔/𝑚3 and 270 K. Simulation without changing the
freestream air speed shows that the electron density increases mainly due to the increase in freestream density.

• Change the surface temperature, mass injection densities and velocities. The injection species may also be
changed by changing their atomic properties both in the input file and air7SpeciesAb.txt file.

5.6 3D Reentry Vehicle (ramC3d.pre)

Keywords:

hypersonic, Navier-Stokes, ballistic, reentry, reactions, ablation

5.6.1 Problem description

This example simulates the ballistic reentry of the RAMC module. The simulation is performed at an altitude of 61
km and an angle of attack of 15∘. The surface of RAMC is assumed to be made up of carbon material. Standard
radiation equilibrium model is used to compute the surface temperature and then ablation of carbon from the surface
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Fig. 5.6: Visualization of density distribution for the Blunt-Body Reentry Vehicle example.
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is obtained. The fluid contains 7 air species and carbon atoms. The reactions and atomic data are given in the external
text data file air7SpeciesAbCarbon.txt. Grid is generated using cubit.

This simulation can be performed using USimHS license.

5.6.2 Creating the run space

The 3D Reentry Vehicle example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template dialog, expand USimHS: Hypersonics.

• Select 3D Reentry Vehicle and press the Choose button.

• In the Choose a name for the new runspace dialog, press the Save button to create a copy of this example in
your run area.

• Press the Save And Process Setup button in the upper right corner of the Editor pane.

The basic example variables are editable in the Editor pane of the Setup window. After any change is made, the Save
and Process Setup button must be pressed again before a new run commences.

5.6.3 Input file features

The following parameters can be varied:

• GRIDFILE - name of grid file

• TEND - Simulation end time (seconds).

• NUMDUMPS - Number of data dumps during the simulation

• REACTIONS_ATOMIC_DATA - name of the file containing reactions and atomic data

• SPEED - free stream velocity

• AOA - angle of attack

• FREESTREAM_DENSITY - free stream density

• FREESTREAM_TEMPERATURE - free stream temperature

• SURFACE_EMISSIVITY - emissivity of the surface

• GAS_EMISSIVITY - emissivity of the hot gas in the vicinity of surface

• MW1_1 - molecular weight of species 1

• ABP01_1 - reference pressure of species 1

• ABDH1_1 - evaporation enthalpy of species 1

• ABT01_1 - reference temperature of species 1

• CFL_CONVECTIVE - CFL condition number for convective terms

• VISCOUS_DIFF_TIMESTEP_FACTOR - Factor to further decrease the internally computed time step based on
kinematic viscosity

• THERMAL_DIFF_TIMESTEP_FACTOR - Factor to further decrease the internally computed time step based
on thermal diffusicity

• BASEMENT_TEMPERATURE - least possible temperature in the domain (K).
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The speed, angle of attack, free stream density, temperature are 7650 𝑚/𝑠, 15∘, 2.816−4𝑘𝑔/𝑚3, and 244.3 𝐾 respec-
tively. Surface material is carbon. Note that the input file comes with an externally generated unstructured mesh using
cubit.

Note: More information about the format of the file containing the reactions and atomic data can be found in the
reference manual at refmanual-SpeciesDataFile.

5.6.4 Running the simulation

After performing the above actions, continue as follows:

• Proceed to the Run window as instructed by pressing the Run icon in the workflow panel.

• To run the simulation, click on the Run button in the upper right corner of the Logs and Output Files pane.

You will also see the engine log output in the Logs and Output Files pane. The run has completed when you see the
output, “Engine completed successfully.”

5.6.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/speciesDens_7.

• Check the Clip All Plots box and set the Z-intercept to 0.

• Drag the slider at the bottom of the Visualization Results pane to move through the simulation in time. The
distribution at the end of the simulation is shown in Fig. ??.

The conservative parameters density, three components of momentum, and energy can also be visualized using
q_0,q_1,..,q_5 respectively.

5.6.6 Further experiments

• Change the flow speed: For example, decrease SPEED to 6000, keeping the other flow parameters unchanged.
Follow the steps and complete the simulation.

• AOA: angle of attack may be changed to simulate trajectory maneuver.

• Altitude: Change in altitude can be simulated by varying the freestream density and temperature.

• Material: Change the surface material to say aluminum. The properties of aluminum MW1_1 = 27.0, ABP01_1
= 0.133, ABDH1_1 = 304807.868, ABT01_1 = 1351.9932. The name of the species in the reactionTableRhs
block has to be updated to Al in the .pre file. In addition to these, the molecular weight and molecular diameter
of species 7 have to be changed in the air7SpeciesAbCarbon.txt file. The change is given below:

MOLECULARWEIGHT START

SPECIES N2 N O2 O NO NO_p1 e Al

28.0 14.0 32.0 16.0 30.0 30.0 5.5e-4 27.0

MOLECULARWEIGHT END

MOLECULARDIA START
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Fig. 5.7: Ablation species density on RAMC during reentry
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SPECIES N2 N O2 O NO NO_p1 e Al

2.5e-10 2.0e-10 5.0e-10 2.0e-10 2.5e-10 2.5e-10 5.0e-13 2.7e-10

MOLECULARDIA END

• Parallel: carry out the simulation on 2, 4, or 8 cores using the MPI options.
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CHAPTER

SIX

COUPLED USIMHS AND USIMHEDP EXAMPLES

These examples illustrate how to solve problems for hypersonic flight where plasma effects are important. These
examples require both a USimHEDP and a USimHS license for execution.

6.1 Arc Plasma Torch (plasmaTorch.pre)

Keywords:

plasma, DC arc

6.1.1 Problem description

This example simulates the arc plasma torch. The simulation includes the formation of a DC arc, ionization of working
gas and expansion through the torch. An axisymmetric domain is utilized for a faster demonstration of the simulation.
Argon gas is the working gas and first ions and electrons are considered. The Navier-Stokes equations are solved for
the overall fluid transport. Individual continuity equations are equations are solved for the species transport. Electron
impact ionization is considered. The rate constants and atomic data, required for the estimation of transport properties,
is provided in the text file argon.txt. Turbulence is included in this simulation using Cheien kEpsilon model described
at http://turbmodels.larc.nasa.gov/ke-chien.html.

This simulation requires both a USimHS and USIMHEDP license.

6.1.2 Creating the run space

The Arc Plasma Torch example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.

• In the resulting New from Template window, expand USimHS.

• Select Arc Plasma Torch and press the Choose button.

• In the resulting dialog, press the Save button to create a copy of this example in your run area.

The basic variables of this problem should now be settable in text boxes in the right pane of the “Setup” window.

6.1.3 Input file features

The following parameters can be varied:

• GENERATE_ARC - option to start and stop the arc (1 or 0)
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• SLPM - Flow rate (standard liter per minute)

• INLET_TEMPERATURE - Fluid temperature at the inlet (K)

• MW - Molecular weight(number)

• REACTIONS_ATOMIC_DATA - Name of the user specified file containing the reaction rates and atomic data

• MAXRATE - Limit to the rate of change of species number density (1/(m^3 s))

• TOTALCURRENT - Total current of the arc (A)

• INITIAL_ELECTRICAL_CONDUCTIVITY - Initial value of electrical conductivity (S/m)

• TURBULENT_INTENSITY - sets the intensity of turbulent fluctuations captured by RANS Model.

• NUMDUMPS - Number of data dumps during the simulation

• TEND - Simulation end time (seconds)

Note that the input file comes with an externally generated unstructured mesh using CUBIT.

6.1.4 Running the simulation

After performing the above actions, continue as follows:

This simulation is run in two steps. Arc is established in the first step and then fluid plasma propagation is solved in
the second step. The default time is set to 60.0e-6 seconds. With the default parameters, it will take 60.0e-6 seconds
to establish the arc. If the properties are changed, TEND has to be chosen appropriately to allow the arc to establish.

STEP-1:

• Press the Save And Process Setup button in the upper right corner.

• Proceed to the run window as instructed by pressing the Run button in the left column of buttons.

• To run the file, click on the Run button in the upper right corner. of the window. You will see the output of the
run in the right pane. The run has completed when you see the output, “Engine completed successfully.”

STEP-2:

• In the editor window (with View Parameters on) turn off the arc by setting GENERATE_ARC = 0

• Increase the TEND to 200.0e-6. Increase the NUMDUMPS to 20. Save And Process Setup again.

• Proceed to the run window as instructed by pressing the Run button in the left column of buttons.

• Restart the simulation from STEP-1 by entering 1 in Restart at Dump Number available on the left-pane.

• Run the simulation as given in STEP-1.

6.1.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize button in the left column of buttons.

• Press the “Open” button to begin visualizing.

• On the left side of the window, click on fluids/avgTemp to view the average temperature as sown in Figure , Fig.
6.1.
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Fig. 6.1: Arc plasma flow in the torch. Average temperature.

6.1.6 Further experiments

• Change the TOTALCURRENT.

• Change the INITIAL_ELECTRICAL_CONDUCTIVITY.

• Run the simulation on 2 and 8 cores using the MPI Runtime Option.

6.2 Radio Communication Blackout (ramCEM.pre)

Keywords:

hypersonic, reentry, plane-wave, blackout

6.2.1 Problem description

This example simulates the propagation of electro-magnetic wave through plasma. The objective is to simulate the
communication blackout on re-entry vehicles. A plane sine wave is sent from the left hand side face of the domain.
Maxwell’s equations are then solved to get the electric and magnetic field components in the simulation domain.

This simulation requires both a USimHS and USIMHEDP license.

6.2.2 Creating the run space

The Radio Communication Blackout example is accessed from within USimComposer by the following actions:

• Select the New from Template menu item in the File menu.
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• In the resulting New from Template window, expand USimHS or USimHEDP.

• Select Radio Communication Blackout and press the Choose button.

• In the resulting dialog, press the Save button to create a copy of this example in your run area.

The basic variables of this problem should now be settable in text boxes in the right pane of the “Setup” window.

6.2.3 Input file features

The following parameters can be varied:

• TEND - Simulation end time (seconds)

• EM_FREQUENCY - wave frequency

• EM_CYCLES - number of EM wave cycles to evolve for

• NUMDUMPS - Number of data dumps during the simulation

• GENERATE_INITIAL_CONDITION - Generate the evolved plasma distribution on the mesh

• GRIDFILE - name of grid file

• REACTIONS_ATOMIC_DATA - name of the consisting of reactions and atomic data

• SPEED - free stream velocity

• AOA - angle of attack

• FREESTREAM_DENSITY - free stream density

• FREESTREAM_TEMPERATURE - free stream temperature

• SURFACE_EMISSIVITY - emissivity of the surface

• GAS_EMISSIVITY - emissivity of the hot gas in the vicinity of surface

• MW1_1 - molecular weight of species 1

• ABP01_1 - reference pressure of species 1

• ABDH1_1 - evaporation enthalpy of species 1

• ABT01_1 - reference temperature of species 1

• CFL_CONVECTIVE - CFL condition number for convective terms

• VISCOUS_DIFF_TIMESTEP_FACTOR - Factor to further decrease the internally computed time step based on
kinematic viscosity

• THERMAL_DIFF_TIMESTEP_FACTOR - Factor to further decrease the internally computed time step based
on thermal diffusicity

• BASEMENT_TEMPERATURE - least possible temperature in the domain (K)

Note that the input file comes with an externally generated unstructured mesh using cubit.

6.2.4 Running the simulation

This example simulates the propagation of an EM wave through the plasma layer surrounding the re-entry ve-
hicle. The first step in the simulation is to generate this plasma distribution, accomplished by setting GENER-
ATE_INITIAL_CONDITION = True (the default). With this choice, generate the plasma distribution by proceeding as
follows:

120 Chapter 6. Coupled USimHS and USimHEDP Examples



USimQuickStart, Release 3.0.1

• Press the Save And Process Setup button in the upper right corner.

• Proceed to the run window as instructed by pressing the Run button in the left column of buttons.

• To run the file, click on the Run button in the upper right corner. of the window. You will see the output of the
run in the right pane. The run has completed when you see the output, “Engine completed successfully.”

Once the simulation has completed, return to the “Setup” window and set GENERATE_INITIAL_CONDITION = False
and increase the NUMDUMPS to 20. Then:

• Press the Save And Process Setup button in the upper right corner.

• Proceed to the run window as instructed by pressing the Run button in the left column of buttons.

• Chose the restart dump number equal to the final dump file from the previous run.

• To run the file, click on the Run button in the upper right corner. of the window. You will see the output of the
run in the right pane. The run has completed when you see the output, “Engine completed successfully.”

6.2.5 Visualizing the results

After performing the above actions, continue as follows:

• Proceed to the Visualize window as instructed by pressing the Visualize icon in the workflow panel.

• Press the Open button to begin visualizing.

• Expand Scalar Data and click the check box for fluids/em_1 to visualize the y-component of electric field as
shown in Figure 6.2. Refer to refmanual-maxwellEqn to see the definitions of remaining components.

Fig. 6.2: Plane EM wave propagation through plasma layer on RAMC during re-entry.
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6.2.6 Further experiments

• Change the wave frequency.

• Run the simulation without plasma. Do not use the restart option and make TEND = 0 and GENER-
ATE_INITIAL_CONDITION = False.

• Parallel: carry out the simulation on 2 and 8 cores using the MPI option.

• USim © 2011-2018 Tech-X Corporation. All rights reserved.

For USim licensing details please email sales@txcorp.com. All trademarks are the property of their
respective owners. Redistribution of any USim™ simulation input file code examples from the USim
Document Set, including the USim In Depth and USim Reference, is allowed provided that this copyright
statement is also included with the redistribution.
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